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This document, which supplements online Help and other product information, contains
important facts about hp OpenView internet services (OVIS).
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Announcements
HP OpenView Internet Services is copyrighted and licensed by Hewlett-Packard
Company. Please refer to the licensing agreements on the installation media.

Former VP-IS Passive Monitoring Components for integration with both VPO and
VP/Windows have been decoupled from OVIS product with the 4.0 release. 
These components are now included with the OpenView Operations 7.0 for
Windows and UNIX releases.

Internet Services 4.0 Release Notes

file:///C|/FrontPage Webs/Content/hpovreports/releasenotes/IOpsReleaseNotes.htm (1 of 20) [2/19/2002 2:27:22 PM]



Future Releases: Windows NT 4.0 support for the OVIS Management Server will end
with the next major release of OVIS.

The hp OpenView Internet Services Concepts Guide has been replaced with the
hp OpenView Internet Services User's Reference Guide.  This new manual is included
in both printed form and as an online .pdf Adobe Acrobat file.

We are no longer supporting HP-UX 10.20 for probe systems.   HP-UX 10.20 is still supported
in the OVIS - NNM integration.

Back to Contents

What's New in OVIS 4.0? 
In an earlier release of OVIS we introduced the HTTP_TRANS probe.
This probe gave you the ability to record a series of steps in a
Web-based transaction, then probe the transaction using the same
series of steps.  In this release, the capability is extended with the
introduction of the new Internet Explorer heavyweight probing. This
new mode uses the Internet Explorer browser version 5.5 or greater to record
and playback a transaction. This mode supports Java Script and gives
response times more representative of a user in a browser.  The URL
and navigation point recording modes have been maintained.  These
modes require significantly less overhead.

■   

Proxy and Web Server authentication and redirection have been added to the
HTTP/HTTPS probe, as well as many new configuration options.

■   

With this release you can build customized Service Level Agreements (SLAs)
and generate reports for them.  You can use the SLA wizard to set
up the Service Level thresholds and create a new SLA.  SLA data is
displayed in the new SLA tab in the Dashboard.

■   

This release also adds integration between OVIS and Cisco Works
Service Management Solution, also known as SMS.  This leverages your
investment by increasing possible probe locations and adding UDP and
VolP capability to OVIS. You can configure the following OVIS probes to
extract data from Cisco SMS: X_SLAM_DNS, X_SLAM_HTTP,
X_SLAM_ICMP, X_SLAM_UDP, X_SLAM_TCP, X_SLAM_VolP (voice
over IP). These are available on Windows NT/2000.

■   

OVIS 4.0 also introduces a new Streaming Media probe for Windows
NT/2000 which supports Real Media Player.

■   

You can create your own custom probes using the custom probes API
provided with OVIS.   This feature consists of the necessary header files
and libraries, a Custom Probes API Guide (CustomProbes.pdf),
a wizard for setting up probe definitions, and two sample probes
with full source code.
NOTE: Support for the custom probes feature is NOT available through
standard support channels.  Technical support for custom probes is only
available through the purchase of hp Partner Care Extended (U2461AA). 
Ask your sale representative for information.

■   

With this release the Dashboard has been enhanced. Customer segmented
reports are now available in the Reports tab when using Restricted Views.
The ability to set the start and stop times for the
data display is added to help you hone in on a problem. There are new
Time Series graphs to show values over time.  And Custom Graphs,

■   
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which are accessed from the Snapshot page's Graphs button, allow
you to create your own custom graphs on any data collected by OVIS.
New database tables and drill down data now reside in the Reporter database.■   

The drilldown data limit, previously set to 100,000 records is now configurable.
This data has been moved to the main database and automatically summarized
to hourly intervals to allow for faster access and reporting.
WARNING: The default data retention may cause the amount of data in the
Reporter database to increase.  Care should be taken to monitor the database
size requirements for at least one week after you update to 4.0 to insure
maximums are not exceeded.

■   

Security has been improved in this release by adding the ability to configure
the communications from probe to management server to use secure
communications, including both server and client certificates.  You set this
up in the Configuration Manager under File > Configure > Web Server.

■   

To keep your remote probes updated, we've added an automatic remote probe
Configuration update capability.  This is enabled when a new probe is deployed
for the first time or when an existing probe is updated with version 4.0.  Then
any time there is a change to a probe's configuration on the server, the
configuration information will automatically be updated on the remote system.

■   

Customer's who created custom reports may want to take advantage of the
following:

* The probe type field has been added to the Service Group data tables.

* Probe data has been added to the Reporter database at detail, hourly
  summary, and daily summary levels.

These changes have been made to enhance and speed up reporting.

■   

Support for Oracle 8.1.7 and SQL Server 2000 has been added.■   

Immediate alarming (duration=0) is now supported, and continuous
alarms may be configured as well.

■   

To help track the number of configured probes and aid you in determining
the proper number of licenses needed, a new "-info" option has been added
to the iopsload program. This option shows you how many 'total logical targets'
are configured. This number will help you determine the required number of
licenses under OVIS's license-to-use model. You can also view this data
directly from the OVIS Configuration Manager by selecting 'Probe Info' from
the 'Tools' menu.

■   

The hp OpenView Internet Services Concepts Guide has been replaced by
the hp OpenView Internet Services User's Reference Guide.  This new
manual is included as a printed document and is available as a .pdf file
(IS_User_Ref_Guide.pdf) with the installed product.

■   

A new online manual is included with Internet Services to help with SQL and
Oracle database configuration (Reporter_Database_Config.pdf).  This
documentation was extracted from the hp OpenView Reporter Installation
and Special Configuration Guide and included with OVIS for your
convenience.

■   

What's New in the OVIS - NNM Integration?

Added ability for ovisClientd to query OVIS HTTP server through a proxy agent.■   

Added bug fix to ovisEventd to ignore ill-formatted OVIS_ALARM SNMP traps.■   
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Added addOVISprobe.ovpl script to aid user additions of custom probe names
to OVISNNM integration files.

■   

Added new probes integrations for IMAP4, STREAM_MEDIA,  X_SLAM_DNS,
X_SLAM_HTTP, X_SLAM_ICMP, X_SLAM_UDP, X_SLAM_TCP, X_SLAM_VolP
probes.

■   

Back to Contents

Updating from a Previous Version of Internet Services
You must update from the 3.5 or 3.6  versions of Internet Services.

NOTE: If the either the management server or remote NT probe installation says
it is unable to install "HP Internet Services" service due
to permissions problems, see the Known Problems/Limitations and Workarounds
section later in the release notes for possible causes and workarounds.

If you are running hp OpenView Reporter on the same system as the OVIS management
server, you must upgrade to Reporter version A.3.01 at the time you install OVIS 4.0.

OVIS 4.0 supports Crystal Reports 8.5 only.  So you must either run repcrys or wait
overnight for the reporting cycle to run to ensure reports display properly.

Both Unix and Windows NT probes have changed, and must be redeployed as part
of the update installation. To help optimize the deployment, there is an InstallShield
package included for NT probe deployment. You will also need to Save Configuration
in the Configuration Manager.  The configuration files will then be automatically
distributed for all remote probe systems.

Current drilldown data will be eliminated during installation.  We advise updating
OVIS during periods when access to drill down data is not required. If you have
procedures in place to extract drill down data they should be run before updating
OVIS.

The default setting for retaining drill down data may cause the amount of data in the
Reporter database to increase.  Care should be taken to monitor the database
size requirements for at least one week after you update to 4.0 to insure
maximums are not exceeded.

Back to Contents

Integrating with Other OpenView Products

hp OpenView Reporter A.3.01●   

hp OpenView Network Node Manager 6.1, 6.2●   

hp OpenView MeasureWare Agent for Windows NT/2000 C.02.55●   

hp OpenView Service Information Portal 2.0, 3.0●   

hp OpenView Operations 5.X and  6.0 for UNIX●   
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hp OpenView VantagePoint for Windows 6.10●   

On systems running OpenView Business Transaction Observer do not install
OVIS server components.  BTO requires a dedicated system.

Check the OpenView web site for current information on compatibility of
OVIS 4.0 with new releases of OVO, NNM and other OpenView products.

Back to Contents

OVIS Languages, Product Names, Product Numbers
This release of OVIS software is currently available in English only.

Product Number Product Name
J5105AA OV  Internet Services 4.0 Media
J5106AA OV Internet Services LTU
J5107AA OV  Internet Services 25 Target Pack LTU
J5108AA HP OV  Internet Services 4.0 Manual

Back to Contents

Known Problems / Limitations and Workarounds

The following areas of Internet Services are either incomplete or known to not function as
expected in the A.04.00 release.

Problem:If you encounter either of the following problems:
Popup boxes indicating that processes (particularly the probe processes or scheduler) are
terminating abnormally due to initialization errors, or
Problems with Web Transaction Recorder transactions recorded in Internet Explorer mode
Workaround: All probes run under the "HP Internet Services" service, which by default is
configured to run as the System account.  If you encounter these problems, reconfigure the
HP Internet Services "System Account" setting by selecting "This account:" and entering the
account (user name) and password that recorded the transaction.  This applies to both the
Management Server and remote probe systems.  This configuration information is accessed
on Windows NT 4.0 via Control Panel > Services > Startup selection, and on Windows 2000
via the Computer Management > Services and Applications > Services > Properties > Log On
selection.

■   

Problem: If the log on account was changed for the "HP Internet Services" service, the
installer may stop and report that it is unable to install the "HP Internet Services" service
due to permission problems.
Workaround: In this case, go to the Services control applet and change the log on
account back to "System Account" and check "Allow Service to Interact with Desktop".
Then press "Retry" in the installer dialog that reported this problem. After the installation
has been completed, change the log on account back to the previous setting.

■   

Concurrency Changes Recommended for heavyweight probing: The Web Transaction
Recorder in Internet Explorer mode is termed "heavyweight probing" because it
programatically runs Internet Explorer 5.5 to do its probing. By default the number of

■   
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probes run at any one time (concurrency) is 32.  When using heavyweight probing it is
recommended to reduce this concurrency to a more reasonable number
(try between 2 and 10).  Because this is a global setting, you must be careful to choose
a concurrency that will not overload the system, but will run probes with a high enough  
concurrency to complete in the probe interval you have specified.  You must also
be sure to allow some slack time for exceptional situations where probes are
running longer than usual and take their full "timeout" allocation.   This concurrency
can be configured in the Configuration Manager in the Probe Location > Edit Network
dialog in the Number of concurrent requests field. 

If you wish to run both heavyweight and lightweight transactions from the same
probe location, and use different concurrencies for the two groups, you can use the
Probe Location Info "New Connection" button to create a new Network Connection
Name for the same network that is already defined. Then you can set the
concurrencies for the two network names, and assign the lightweight transactions
to one (with the higher concurrency) and the heavyweight transactions to the
other (with lower concurrency). Note that all probes for one network
will have to complete before the probes for the other network can begin, so some testing
is required to make sure the two sets of probes will be able to complete within the defined
probe interval.
Remote Probes redeployed after OVIS 4.0 installed: If you have remote probes, you will
need to redeploy them after the OVIS 4.0 release is installed.

■   

R555014890: OVIS 4.0 and Service Information Portal 2.0 or 3.0 integration does not
work. Change request B553002229 (NSMfc31846) has been filed against SIP 3.0
regarding this problem.

■   

R555014847: Attempt to print User's Reference Guide or any other .pdf document from
Acrobat Reader causes an abort.
Workaround: Go to the Adobe web site (http://www.adobe.com/products/acrobat/),
download a new copy of Acrobat Reader, and install it.

■   

R555014861: If OV Internet Services version 3.0, 3.5, or 3.6 was installed before
Reporter A.3.01, then repcrys will be scheduled to run at 1:00 am, causing the
report cycles to run before the gather and gathercoda processes run.  This means
that the data for the previous day will not be included in the reports. Note this
is only a problem if the Reporter product is installed on the same system as the
OVIS management server.
Workaround: Change the Schedule in the Reporter User Interface to schedule
repcrys at 2:00 am instead of 1:00 am.

■   

R555014727: The Destination Folders dialog sometimes displays the incorrect
information during installation. When you have an existing application installed   
(OV Reporter, OV Internet Services, Web Transaction Observer, OV Performance
Agent), plus an OV Operations Agent deployed to this system, the installer
sometimes doesn't display the correct directory in the Destination Folders dialog.
Workaround: Ignore the message, it actually will install to the application's correct,
existing directory.

■   

Problem: If you are using the OVO for UNIX (VPO) Service Navigator integration 
with VPO 6.x, views are nor properly synchronized because the necessary VPO
delete function does not work. This is not a problem on VPO 5.3.
Required VPO patches: PHSS_22762 and PHSS_22696
These patches make the -replace command work so that in VPO 6.0 the OVIS
services are replaced properly.

■   

R555008406: Windows 2000 Dial-up probe fails.
Workaround: When selecting a Dial-up Network connection, you must
use the Dial-Up Network Entry. If Dial-Up Information is not available,
create new a Dial-up phone book entry and refer to this name in Dial-Up

■   
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Network Entry section.

R555008783: Message in status.reporter file: "ERROR: System Data Source
"Reporter" not found in ODBC or could not be created".  The Reporter database
(<install dir>\data\datafiles\Reporter.mdb) might or might not be created.
Workaround for customers using MS Access Database: These steps MUST
be followed in order.

Open the Control Panel>Services>select Reporter Service and
press the Stop button.

1.  

Open Control Panel > ODBC Data Sources. Choose the
System DSN tab and remove the Reporter entry.

2.  

It is strongly recommend that you reboot the system now.3.  

Open the Control Panel > ODBC Data Sources. Choose the
System DSN tab.

4.  

Select Add, Microsoft Drivers (*.MDB), and click the Finish button.
At the Data Source Name, type Reporter. Of the Options, choose
Select the Database.  

Warning!! DO NOT CREATE A NEW REPORTER.MDB, IF THE
DEFAULT REPORTER.MDB WHICH WAS INSTALLED DURING THE
INSTALLATION PROCESS IS STILL UNDER THE DIRECTORY
<install dir>\DATA\DATAFILES\REPORTER.MDB.

5.  

Accept other default settings.6.  

Close the ODBC Admin Tools and restart the Reporter Service.

You should see the Reporter establishing a connection with the
Reporter.MDB and logging in.

7.  

■   

Problem: Whenever an OVO for Windows or UNIX agent is installed after OVIS,
you must reboot in order to ensure that alarm forwarding works correctly.

■   

R555014853: Japanese Characters in the Dashboard are incorrect with Netscape 4.7
Workaround: The workaround can also be applied to other language sets. In
versions of Netscape earlier than 6, Japanese characters can be incorrect or
appear as blocks. To fix this, inside of Netscape go to Edit->Preferences.
Then in the Preferences window select the tree item Fonts under Appearance.

In the Fonts window select the language that you are having problems with,
in this case Japanese. Make sure that the fonts selected are appropriate
for the encoding. Then change the setting for document fonts from
"Use document-specified fonts, including Dynamic Fonts" to
"Use my default fonts, overriding document-specified fonts". Click OK
and refresh the screen. Repeat as necessary for additional encodings.

After the above change the Japanese characters will appear correctly
in Dashboard reports.

■   

R555014404: When NNM and OVIS English versions are both running on a
Japanese system only the English text is viewable in the NNM Event Browser.

■   
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Japanese text is either garbage or missing. There is no resolution at this time.

 

NNM Integration Component:

There are several known minor issues with the OVIS/NNM integration
package, most with simple workarounds.

Problem: ODBC Roll Forward/Backward Errors 
Cause: Occasionally, stopping the NNM services (ovstop) while
ovw is running can later cause the database to fail to start with
error messages stating that "Roll Forward" or "Roll Backward"
operations failed. This problem has only been seen so far on Windows NT.
The problem is a corrupt database log file. This problem has been
improved with the new Solid Server (3.51) shipped with NNM 6.2,
however the problem has still been observed only at lesser frequency.
Workaround: Run the command: $OV_BIN/ovisdb.ovpl -cl -restart
The database should then be running normally, without loss of data.

■   

Problem: ODBC Cannot Find Source "tcpip 2691" 
Cause: Occasionally, the database does not shutdown properly.
This is also believed to be related to running ovw sessions when
ovstop is issued. 
Workaround: Run the command: $OV_BIN/ovisdb.ovpl -restart
to properly shutdown and restart the database, without loss of data.

■   

Problem: Symbol Display 
Cause: There are a few scenarios where commands are stored to the
command database, but are not performed on an open map. This happens,
for example, if the persistence level is not set to "All Levels" (see the
Internet Services User's Reference Guide), or if the node is not managed
by NNM. The NNM menu
choice >Internet Services—> Rebuild Internet Services Symbols
causes NNM to delete all symbols that have the "ovisIsOVIS" field set
TRUE, and then reperforms all commands in the command database.
This ensures that the map reflects what is currently in the database. 
Workaround: There are mechanisms built into the integration package
to recover missed configuration changes and alarms. However, if you
suspect that NNM is not synchronized with OVIS, the script
$OV_BIN/ovisclean.ovpl completely clears the command database
and causes NNM to pull all of the latest configuration and alarm data.
The script also rebuilds all symbols. Before running ovisclean.ovpl,
make sure to shut down any running OVW sessions.

■   

Problem: Multiple Service Groups of the Same Type do not display
correctly.
Cause: Because service symbols are created by type
(HTTP, DNS, FTP, etc.) no distinction is made between service groups
of the same type for a given target node. In other words, if you configure

■   

Internet Services 4.0 Release Notes

file:///C|/FrontPage Webs/Content/hpovreports/releasenotes/IOpsReleaseNotes.htm (8 of 20) [2/19/2002 2:27:22 PM]



two service groups, such as SG1 and SG2, that are both HTTP service
groups, and both service groups contain the target node foo.com, you
can see that on the NNM map the node symbol for foo.com contains
only one HTTP service symbol. All alarm symbols for both SG1 and
SG2 are created under this one HTTP service symbol. More importantly,
if you later delete one of these service groups, the NNM integration
package responds as though the entire HTTP service is being deleted,
and removes the HTTP symbol under foo.com. 
Workaround: Run the ovisclean.ovpl script to restore the remaining
service group.

Problem: Changing Customer Name in OVIS is not automatically
updated by NNM. As a result, events targeted to that customer are
logged as errors, and the symbol reflecting the customer's old name
is not updated.
Workaround: Run the ovisclean.ovpl script to force the NNM integration
to re-establish the customer under the new name.

■   

Problem: Inconsistent Customer Views Status Propagation between
NNM and OVIS.
Cause: In cases where Customer Views is installed on the NNM
node that is integrated with OVIS, there is inaccurate status propagation
to customer symbols displayed in Customer Views symbols. For any
OVIS target node that serves more than one customer, the status
propagation to the node reflects the status of all the customers
served by the node. However, if a customer symbol in Customer
Views has that node beneath it on the hierarchy (for example, in the
"Servers" container), the status of the customer symbol reflects the
status of all customers served by that node. This is due to the fact
that OVIS integration creates a child symbol for each customer
served by a given node, and thus the node's status is determined
by the status of all its customers. Because the customer symbol
in Customer Views obtains its status from the node, the status
for a given Customer Views customer symbol becomes a function
of all customers served by the node. The problem arises from
inconsistent modeling of customer, service, and targets between
NNM and OVIS.
Workaround: At this time there is no fix or workaround for this problem.

■   

Back to Contents

List of Files and Versions
List of Installed Files for Internet Services A.04.00.

In directory <installation directory>\bin\
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File Binary Versions ASCII
Versions Feature

CFX2032.DLL 3.0.33.0  Chart FX Library,
Software FX, Inc.

CODA_ACCESS.DLL 1.7.0.2 A.07.02
Library to communicate
with OV Operations 7
Agent

DCE.DLL   datacomm library
Dascom, Inc.

DLLVERSIONS.EXE 1.3.1.0 A.3.01
Finds and lists dlls and
versions that Reporter
uses

ExportIops.exe 1.4.0.0 A.04.00 Builds The Configuration
Files

GATHER.EXE 1.3.1.0 A.3.01 OpenView Performance
Agent data gatherer

GATHERCODA.EXE 1.3.1.0 A.3.01
OVO for Windows 7
performance subagent
data gatherer

HPMXLICOBJECT.DLL 3.50.20706.2  License Library
HPMXLICOBJECTRES.DLL 3.50.20707.3  License Library
IopsCollector.exe 1.4.0.0 A.04.00 Summarizes Probe Data
IopsConfig.exe 1.4.0.0 A.04.00 Configuration Manager
IopsDrillCfg.exe 1.4.0.0 A.04.00 TraceTable Utility

IOPSLoad.exe 1.4.0.0 A.04.00
Loads/Saves
Configuration
Information in XML.

IOPSMaint.exe 1.4.0.0 A.04.00 Summarizes Detail Data
LLBSERVER.EXE 2.5.2.12   

NewIops.exe 1.4.0.0 A.04.00 Creates OVIS Specific
Tables in Database

OVBBCBASE.DLL 2.5.2.12  Datacomm library
OVBBCHTTP.DLL 2.5.2.12  Datacomm library
OVBBCIO.DLL 2.5.2.12  Datacomm library
OVBBCNET.DLL 2.5.2.12  Datacomm library
OVBBCSSL.DLL 2.5.2.12  Datacomm library
OVBBCTHREAD.DLL 2.5.2.12  Datacomm library
OVBBCXML.DLL 2.5.2.12  Datacomm library
OVCONSNOTIFY.DLL 1.2.0.0  OV Operations library

ov.dll   NNM Library for
SendtoNNM

ovsnmp.dll   NNM Library for
SendtoNNM

ovutil.dll   NNM Library for
SendtoNNM

ovw.dll   NNM Library for
SendtoNNM
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perfstat.exe  19.0.0.2 Status Utility for Services
and Files

removeIops.dll  A.04.00 Uninstall dll for
Internet Services

PTHREAD.DLL   datacomm library  
Dascom, Inc.

REPCRYS.EXE 1.3.1.0 A.03.01 Reporter report
generator

REPLOAD.EXE 1.3.1.0 A.3.01 Loads report templates
from text file

REPMAINT.EXE 1.3.1.0 A.3.01 Reporter database
maintenance

REPORTSVC.EXE 1.3.1.0 A.3.01 Reporter service

REPORTSRVCAT.DLL 0.2.73.0  
Reporter service
Message Catalog

sendtonnm.exe  A.04.00
Sends Alarms for
SNMP Alarm
Destinations

TRC.DLL 1.7.0.0  Tracing library
TRCMSGS.DLL 3.0.3.2  Tracing library

WebRecorder.exe  A.04.00 HttpTransProbe and GUI
Interface

XERCES-C_1_5_1.DLL 1.5.1.0  Xerces XML parser
library

xerces-c_1_0.dll  1.0.0.0 Apache Library ©
Apache Software

IOpsSlaEvaluator.exe  A.04.00 Evualates SLOs, SLAs,
and Conformance

 

In directory <installation directory>\probes

File Binary Versions
ASCII

Version
Feature

Config.dat   Contains Probe Configurations
OvisApi.dll 1.4.0.0 A.04.00 Internet Services API
dig.exe   DNS Tool
probeAnyTcp.exe 1.4.0.0 A.04.00 TCP Probe
probeDhcp.exe 1.4.0.0 A.04.00 DHCP Probe
probeDial.exe 1.4.0.0 A.04.00 Dial Probe
probeDns.exe 1.4.0.0 A.04.00 DNS Probe
probeFtp.exe 1.4.0.0 A.04.00 FTP Probe
probeHttp.exe 1.4.0.0 A.04.00 HTTP Probe
probeHttpTrans.exe 1.4.0.0 A.04.00 HTTPTrans Probe
probeHttpTrans2.exe 1.4.0.0 A.04.00 Heavy Weight HTTPTrans Probe
probeIcmp.exe 1.4.0.0 A.04.00 ICMP Probe
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probeImap.exe 1.4.0.0 A.04.00 IMAP Probe
probeLdap.exe 1.4.0.0 A.04.00 LDAP Probe
probeNntp.exe 1.4.0.0 A.04.00 NNTP Probe
probeNtp.exe 1.4.0.0 A.04.00 NTP Probe
probePop3.exe 1.4.0.0 A.04.00 POP3 Probe
probeRadius.exe 1.4.0.0 A.04.00 Radius Probe
probeSLAM.exe 1.4.0.0 A.04.00 Cisco SLM integration Probe
probeSMedia.exe 1.4.0.0 A.04.00 Streaming Media Probe
probeSmtp.exe 1.4.0.0 A.04.00 SMTP Probe
probeWap.exe 1.4.0.0 A.04.00 WAP Probe
scheduler.exe 1.4.0.0 A.04.00 Probe Scheduler

Trusted.txt   SSL Certificate
information

xerces-c_1_0.dll  1.0.0.0 Apache Library © Apache Software

 

In directory <installation directory>\newconfig\

File Binary Versions
ASCII

Version
Feature

remote_probes_install.exe 1.4.0.0 A.04.00 Remote Probes Install Package

 

In directory <installation directory>\HPOV_IOPS\cgi-bin

File Binary Versions
ASCII

Version
Feature

Analyzer.exe 1.4.0.0 A.04.00 Engine for On Demand Reports
RepIops.exe 1.4.0.0 A.04.00 Dashboard Report Generator
Analyzertest.exe 1.4.0.0  Analyzer test program
Analyzertest.htm   Analyzer test web page

 

In directory <installation directory>\HPOV_IOPS\isapi

File Binary Versions
ASCII

Version
Feature

DistribMgrExt.dll 1.4.0.0 A.04.00 Auto Config Deploy Library
measEvent2.dll 1.4.0.0 A.04.00 Receives/Inserts data into TraceTable

alarmEvent.dll 1.4.0.0 A.04.00 Processes Incoming Data for SLO
Violations.

 

In directory <installation directory>\SDK\Internet Services\
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File Binary Versions
ASCII

Version
Feature

ProbeWizard.exe 1.4.0.0 A.04.00 Configuration Interface for Custom Probes

 

In directory <windows>\system32

File
Binary

Version
Description

ADSSECURITY.DLL 1.0.0.1 ADSI SDK Resource Kit library
ASYCFILT.DLL 2.40.4275.1 OLE for Windows library
ATL.DLL 3.0.8449.0 ATL Module for Windows (ANSI)
CFX2032.DLL 3.0.33.0  
COMCAT.DLL 4.71.1460.1 Microsoft Component Category Manager Library
CTL3D32.DLL  Microsoft 3D Windows Controls

DBMSLPCN.DLL 2000.80.382.0 Client-Side Local Inter-Process Communication
(LPC) Net Library

DBMSSHRN.DLL 2000.80.194.0 ConnectTo RPC Net Library
DBNETLIB.DLL 2000.80.380.0 Winsock Oriented Net DLL for SQL Clients
DZIP32.DLL 3.0.0.15 Inner Media DynaZIP-32 ZIP
IMPROV.DLL 2000.80.382.0  
INETWH32.DLL 1.10.1.1 Blue Sky Software
LIBARM32.DLL 3.00.00.00 Application Response Measurement Library (stub)
MFC42.DLL 6.0.8447.0 MFCDLL Shared Library - Retail
MSCPXL32.DLL  Microsoft ODBC Code Page Translator
MSSTKPRP.DLL 6.0.81.69 msprop32.ocx
MSVCIRT.DLL 6.0.8168.0 Microsoft C++ Runtime Library
MSVCP60.DLL 6.0.8972.0 Microsoft C++ Runtime Library
MSVCRT.DLL 6.0.8397.0 Microsoft C Runtime Library
MSVCRT20.DLL 2.10.00.00 Microsoft C Runtime Library
MSVCRT40.DLL 4.20.00.6172 Microsoft C Runtime Library Forwarder
ODBC32.DLL 3.520.7326.00 Microsoft ODBC Driver Manager
ODBC32GT.DLL 3.520.7326.00 Microsoft ODBC Driver Generic Thunk
ODBCAD32.EXE  Microsoft ODBC Control Panel Startup
ODBCBCP.DLL 2000.80.380.0 Microsoft BCP for ODBC
ODBCCP32.CPL 3.520.7326.00 Microsoft ODBC Control Panel Device
ODBCCP32.DLL 3.520.7326.00 Microsoft ODBC Administrator
ODBCCR32.DLL 3.520.7326.00 Microsoft ODBC Cursor Library
ODBCINT.DLL 3.520.7326.00 Microsoft ODBC Localized Resource DLL
ODBCJI32.DLL 3.520.7326.00 Microsoft ODBC Desktop Driver Pack
ODBCJT32.DLL 4.0.6019.0 Microsoft ODBC Desktop Driver 3.5
ODBCTL32.DLL 3.51.1029.00 Microsoft ODBC Helper Function DLL
OLEAUT32.DLL 2.40.4275.1 OLE for Windows library
OLEPRO32.DLL 5.0.4275.1 Microsoft OLE Property Support
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PDH.DLL 5.0.2174.1 Performance Data Provider Helper
PSAPI.DLL 5.0.2134.1 Process Status Helper
RACLS.EXE 2.0.31.0  
RHMMPLAY.DLL 2.0.0.0 WinHelp Video Player 32-bit
SKY32V3C.DLL 1.0.0.0 Creative Development Image Library
SQLSRV32.DLL 2000.80.380.0 Microsoft SQL Server ODBC Driver

SQLUNIRL.DLL 2000.80.380.0 String Function .DLL for SQL Enterprise
Components

VBAJET32.DLL  Visual Basic for Applications Development
Environment - Expression Service Loader

VBAR332.DLL  Visual Basic for Apps Expression Svc

 

In directory C:\Program Files\Microsoft SQL Server\MSSQL$OVOPS\binn

File Name Binary Version Description
ADSSECURITY.DLL 1.0.0.1 ADSI SDK Resource Kit library
CMDWRAP.EXE 2000.80.382.0 SQL Login Integration Procedures DLL
COMNEVNT.DLL 2000.1.10.0 Common Event Model DLL
DBGHELP.DLL 5.0.2195.1 Windows Image Helper
MSDBI.DLL 6.10.8226.0 Microsoft (R) VC Program Database

ODSOLE70.DLL 2000.80.382.0 OleAut driver DLL containing SQL Server sp_OA
extended stored procedures

OPENDS60.DLL 2000.80.194.0 SQL Open Data Services DLL
SEMMAP.DLL 2000.80.194.0 SEMMAP Resource DLL

SEMNT.DLL 2000.80.382.0 Window NT Specific DLL for SQL Enterprise
Manager

SQLAGENT.DLL 2000.80.382.0 SQL Server Agent event strings DLL
SQLAGENT.EXE 2000.80.382.0 Microsoft SQL Server Agent
SQLATXSS.DLL 2000.80.382.0 SQLServerAgent Active Scripting subsystem DLL
SQLBOOT.DLL 2000.80.194.0  

SQLCMDSS.DLL 2000.80.382.0 SQLServerAgent Command Execution subsystem
DLL

SQLCTR80.DLL 2000.80.382.0 SQL Server Performance Acquisition DLL
SQLIMAGE.DLL 5.0.2031.1 Windows NT Image Helper

SQLMAINT.EXE 2000.80.382.0 SQL Server Database Maintenance Plan Wizard
Executor

SQLREPSS.DLL 2000.80.382.0 SQLServer Agent Replication Subsystem Library
SQLRESLD.DLL 2000.80.382.0 SQL Enterprise Manager Reesource DLL Loader
SQLSERVR.EXE 2000.80.384.0 SQL Server Windows NT
SQLSNMP.DLL 2000.80.194.0 MS SQL SNMP Extension DLL
SQLSVC.DLL 2000.80.382.0 Service Layer DLL for SQL Enterprise Workbench
SSMSAD70.DLL 2000.80.194.0 ADSP Net DLL for SQL Server

SSMSLPCN.DLL 2000.80.382.0 Client-Side Local Inter-Process Communication
(LPC) Net Library

SSMSRP70.DLL 2000.80.382.0 ListenOn RPC Net Library

Internet Services 4.0 Release Notes

file:///C|/FrontPage Webs/Content/hpovreports/releasenotes/IOpsReleaseNotes.htm (14 of 20) [2/19/2002 2:27:22 PM]



SSMSSH70.DLL 2000.80.194.0 ListenOn RPC Net Library
SSMSVI70.DLL 2000.80.194.0 ListenOn VINES Net Library
SSNETLIB.DLL 2000.80.382.0 Winsock Oriented Net DLL for SQL Server
SSNMPN70.DLL 2000.80.194.0 Named Pipes Net DLL for SQL Server
UMS.DLL 2000.80.382.0 SQL User Mode Scheduler DLL
XPLOG70.DLL 2000.80.382.0 SQL Login Integration Procedures DLL

XPQUEUE.DLL 2000.80.382.0 SQL Server Replication Extended Procs for
Queued Updating Subscribers

XPREPL.DLL 2000.80.382.0 SQL Server Replication Extended Stored
Procedures Library

XPSQLBOT.DLL 2000.80.194.0  

XPSTAR.DLL 2000.80.382.0 Extended Stored Procedure DLL for SQL
Enterprise Manager

SQLDATA.DLL 2000.80.382.0 SQL Sorting Data DLL
SQLSORT.DLL 2000.80.382.0 SQL Sorting DLL

 

In directory C:\Program Files\Microsoft SQL Server\80\Tools\binn

File Name Binary Version Description
AXSCPHST.DLL 2000.80.194.0 Active Scripting Host for SQL
BCP.EXE 2000.80.382.0 SQL bulk copy tool
CLDTCSTP.EXE 2000.80.194.0 SQL Server DTC setup wrapper
CNFGSVR.EXE 2000.80.194.0 SQL Server Server Configuration
CNVREM.DLL 2000.80.194.0 RPC wrapper DLL for two machine version upgrades
CNVSVC.EXE 2000.80.194.0 RPC Service for two machine version upgrades
CUSTTASK.DLL 2000.80.382.0 DTS Custom Task implementation file
DCOMSCM.EXE 2000.80.194.0 SQL Server DCOM SCM Object
DTCSETUP.EXE 4.71.1015.0 MS DTC stand-alone setup
DTSFFILE.DLL 2000.80.384.0 DTSFlatFile Rowset Provider DLL
DTSPKG.DLL 2000.80.382.0 DTSPackage Service Provider DLL
DTSPUMP.DLL 2000.80.382.0 DTSDataPump Service Provider DLL
DTSRUN.EXE 2000.80.382.0 DTS Package CommandLine Execution
OSQL.EXE 2000.80.382.0 SQL query tool
PFCLNT80.DLL 2000.80.382.0 SQL Server Profiler DLL
SCM.EXE 2000.80.382.0 SQL Setup SCM
SQLRESLD.DLL 2000.80.382.0 SQL Enterprise Manager Reesource DLL Loader
SEMMAP.DLL 2000.80.194.0 SEMMAP Resource DLL

SEMNT.DLL 2000.80.382.0 Window NT Specific DLL for SQL Enterprise
Manager

SQDEDEV.DLL 2000.80.384.0 SQL Setup Enumeration APIs

SQLADHLP.EXE 2000.80.382.0 Microsoft SQL Server Active Directory Helper
Service

SQLDMO.DLL 2000.80.382.0 Distributed Management Objects OLE DLL for SQL
Enterprise Manager

SQLMANGR.EXE 2000.80.382.0 SQL Server Service Manager
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SQLREDIS.EXE 5.0.2919.6304 Win32 Cabinet Self-Extractor
SQLRESLD.DLL 2000.80.382.0 SQL Enterprise Manager Resource DLL Loader
SQLSVC.DLL 2000.80.382.0 Service Layer DLL for SQL Enterprise Workbench
SQLVDI.DLL 2000.80.194.0 Virtual Device Interface for BACKUP/RESTORE
SVRNETCN.DLL 2000.80.382.0 SQL Server Network Utility DLL
SVRNETCN.EXE 2000.80.382.0 SQL Server Network Utility EXE
W95SCM.DLL 2000.80.194.0 SQL Server Windows 95 Lite SCM
MSGPROX.DLL 2000.80.382.0 SQL Server Proxy Message Datasource Provider

 

In directory C:\Program Files\Microsoft SQL Server\80\Tools\binn\Resources

File Name Binary Version Description
DISTRIB.EXE 2000.80.194.0 SQL Server Replication Distribution Agent
IMPPROV.DLL 2000.80.382.0 Import OLE DB Provider for SQL Server
MERGETXT.DLL 2000.80.382.0 SQL Server Text Merge Resolver
RDISTCOM.DLL 2000.80.382.0 SQL Server Replication Distribution Library
REPLAGNT.DLL 2000.80.194.0 SQL Server Replication Agent Library
REPLDIST.DLL 2000.80.194.0 SQL Server Replication Distributor Provider
REPLDP.DLL 2000.80.382.0 SQL Server Replication Internal Distributor Provider
REPLDSUI.DLL 2000.80.194.0 SQL Server Directory Service UI Handler
REPLDTS.DLL 2000.80.194.0 SQL Server Replication OLEDB provider Library
REPLERRX.DLL 2000.80.194.0 Microsoft SQL Replication Errors Control 8.0
REPLMERG.EXE 2000.80.382.0 SQL Server Replication Merge Agent
REPLPROV.DLL 2000.80.382.0 SQL Server Replication Merge Provider
REPLPROX.DLL 2000.80.194.0 SQL Server Proxy Merge Replication Provider
REPLREC.DLL 2000.80.382.0 SQL Server Replication Merge Reconciler
REPLSUB.DLL 2000.80.382.0 SQL Server Replication Subscriber Provider

REPLSYNC.DLL 2000.80.194.0 SQL Server Replication Synchronization Manager
Handler

RINITCOM.DLL 2000.80.382.0 SQL Server Replication Snapshot Library
SNAPSHOT.EXE 2000.80.382.0 SQL Server Replication Snapshot Agent

SPRESOLV.DLL 2000.80.382.0 SQL Server Replication Stored Procedure Merge
Resolver

SQLDISTX.DLL 2000.80.382.0 Microsoft SQL Distribution Control 8.0
SQLINITX.DLL 2000.80.382.0 Microsoft SQL Snapshot Control 8.0
SQLMERGX.DLL 2000.80.382.0 Microsoft SQL Merge Control 8.0
SQLRESLD.DLL 2000.80.382.0 SQL Enterprise Manager Reesource DLL Loader
SSRADD.DLL 2000.80.382.0 SQL Server Additive Conflict Resolver
SSRAVG.DLL 2000.80.382.0 SQL Server Averaging Conflict Resolver
SSRDOWN.DLL 2000.80.382.0 SQL Server Download Only Resolver
SSRMAX.DLL 2000.80.382.0 SQL Server Maximum/Latest Conflict Resolver
SSRMIN.DLL 2000.80.382.0 SQL Server Minimum Conflict Resolver

SSRPUB.DLL 2000.80.382.0 SQL Server Subscriber Always Wins Conflict
Resolver
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SSRUP.DLL 2000.80.382.0 SQL Server Upload Only Resolver

 

In directory <windows>\system32 (Crystal Reports Version 8.5)

File Name Binary Version Description
CRBAS14.DLL 3.50.0.0 MERANT Base ODBC DLL
CROR815.DLL 3.60.0.13 MERANT Oracle8 ODBC Driver
CRPAIG80.DLL 8.0.1.3 Crystal Reports Text Object Support
CRPE32.DLL 8.5.0.217 Crystal Reports Print Engine
CRUTL14.DLL  MERANT Utilities DLL
EXLATE32.DLL 8.5.0.217 Crystal Reports HTML Translator
IMPLODE.DLL  Crystal Reports Compression Library
P2SODBC.DLL 8.5.0.72 Crystal Reports Physical Server DLL

 

In directory \Program Files\Seagate Software\Shared (Crystal Reports Version 8.5)

File Name Binary Version Description
PG32CONV.DLL  Crystal Reports Auxiliary Chart DLL
CRTSLV.DLL 8.5.0.144 TSLV Module
EXPORTMODELLER.DLL 8.5.0.35 ExportModeller Module
S2SQLPRS.DLL 8.0.0.4 SQL Expression Editor Parser
SSCSDK80.DLL 2.2.9.4 Crystal Reports Chart Engine

 

In directory <windows>\crystal (Crystal Reports Version 8.5)

File Name Binary Version Description
P2IXBSE.DLL 8.0.100.1 Crystal Reports Physical Database DLL
P2LODBC.DLL 8.5.0.19 Crystal Reports Physical Server DLL
U252000.DLL 8.0.0.0 Year 2000 Support DLL
U25DTS.DLL 8.0.0.0 Date Time String Export Destination DLL
U2DDISK.DLL 8.5.0.1 Disk Export Destination DLL
U2FHTML.DLL 8.5.0.77 HTML Export Format DLL
U2L2000.DLL 8.0.0.0 User Function Library for Year 2000 Support
U2LCOM.DLL 8.0.0.0 User Function Library for COM Manager
U2LDTS.DLL 8.0.0.0 User Function Library for Date Time String Export
U2LEXCH.DLL 8.0.0.1 User Function Library for Exchange
U2LFINRA.DLL 8.0.0.1 User Function Library for Financial Calculations
U2LSAMP1.DLL 8.0.0.1 User Function Library Sample
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Legal Notices
The information in this document is subject to change without notice.

Hewlett-Packard makes no warranty of any kind with regard to this manual,
including but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. Hewlett-Packard shall not be held liable
for errors contained herein or direct, indirect, special, incidental or consequential
damages in connection with the furnishing performance, or use of this material.

Warranty. A copy of the specific warranty terms applicable to your Hewlett- Packard
product and replacement parts can be obtained from your local Sales and Service Office.

Restricted Rights Legend. All rights are reserved. No part of this material may be
copied, reproduced, or translated to another language without the prior written
consent of Hewlett-Packard Company. The information contained in this material
is subject to change without notice.

Use, duplication or disclosure by the U.S. Government is subject to restrictions
as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and
Computer Software clause at DFARS 252.227-7013 for DOD agencies,
and subparagraphs (c) (1) and (c) (2) of the Commercial Computer Software
Restricted Rights clause at FAR 52.227-19 for other agencies.

HEWLETT-PACKARD COMPANY
United States of America

Copyright Notices. ©Copyright 2001 Hewlett-Packard Company, all
rights reserved.

Reproduction, adaptation, or translation of this document without prior
written permission is prohibited, except as allowed under the copyright laws.

Trademark Notices.

Adobe® is a trademark of Adobe Systems Incorporated.
Apache™ is a trademark of the Apache Software Foundation.
Check Point FireWall-1™ is a trademark of Check Point Software Technologies Ltd.
HP-UX Release 10.20 and later and HP-UX Release 11.00 and later (in both 32
and 64-bit configurations) on all HP 9000 computers are Open Group UNIX 95
branded products.
Intel486 is a U.S. trademark of Intel Corporation.
iPlanet™ International and Netscape FastTrack Web Server™ are
trademarks of the Sun/Netscape Alliance.
Java™ is a U.S. trademark of Sun Microsystems, Inc.
Microsoft® is a U.S. registered trademark of Microsoft Corporation.
Netscape™ and Netscape Navigator™ are U.S. trademarks of Netscape
Communications Corporation.
OpenView® is a registered U.S. trademark of Hewlett-Packard Company.
Oracle® is a registered U.S. trademark of Oracle Corporation, Redwood City,
California.
Oracle Reports™, Oracle7™, and Oracle7 Server™ are trademarks of Oracle
Corporation, Redwood City, California.
OSF/Motif® and Open Software Foundation® are trademarks of Open Software
Foundation in the U.S. and other countries.
Pentium® is a U.S. registered trademark of Intel Corporation.
SQL*Net® and SQL*Plus® are registered U.S. trademarks of Oracle
Corporation, Redwood City, California.
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Stronghold™ is a trademark of C2Net Software Inc.
UNIX® is a registered trademark of the Open Group.
Windows NT® is a U.S. registered trademark of Microsoft Corporation.
Windows® and MS Windows® are U.S. registered trademarks of
Microsoft Corporation.
Microsoft® Internet Explorer is a registered trademark of Microsoft Corporation.
Certicom, the Certicom logo, SSL Plus, and Security Builder are trademarks of
Certicom Corp.  Copyright © 1997-2000 Certicom Corp.  Portions are Copyright
1997-1998, Consensus Development Corporation, a wholly owned subsidiary of
Certicom Corp. All rights reserved. Contains an implementation of NR signatures,
licensed under U.S. patent 5,600,725.  Protected by U.S. patents 5,787,028;
4,745,568; 5,761,305.  Patents pending.

This product includes a copy of the Microsoft Data Engine (MSDE), redistributed
under the terms of Microsoft's End-User License Agreement.
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OpenLDAP Public License
The OpenLDAP Public License,  Version 2.3, 28 July 2000

Redistribution and use of this software and associated documentation ("Software"),
with or without modification, are permitted provided that the following conditions
are met:

1. Redistributions of source code must retain copyright statements and notices.

2. Redistributions in binary form must reproduce applicable copyright statements
and notices, this list of conditions, and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. Redistributions must contain a verbatim copy of this document.

4. The name "OpenLDAP" must not be used to endorse or promote products
derived from this Software without prior written permission of the OpenLDAP
Foundation.

5. Products derived from this Software may not be called "OpenLDAP"
nor may "OpenLDAP" appear in their names without prior written permission
of the OpenLDAP Foundation.

6. Due credit should be given to the OpenLDAP Project ( http://www.openldap.org/).

7. The OpenLDAP Foundation may revise this license from time to time. 
Each revision is distinguished by a version number.  You may use the Software
under terms of this license revision or under the terms of any subsequent revision
of the license.

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND CONTRIBUTORS
``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL
THE OPENLDAP FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
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(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
OF THE POSSIBILITY OF SUCH DAMAGE.

OpenLDAP is a trademark of the OpenLDAP Foundation.

Copyright 1999-2000 The OpenLDAP Foundation, Redwood City,
California, USA.  All Rights Reserved.  Permission to copy and
distributed verbatim copies of this document is granted.

NetBSD C Library Source
Copyright (c) 1992, 1993
The Regents of the University of California. All rights reserved.

This software was developed by the Computer Systems Engineering group
at Lawrence Berkeley Laboratory under DARPA contract BG 91-66 and
contributed to Berkeley.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
SUCH DAMAGE.
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